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Practical Python Programming

ETLC 5-013 Computer Access

1. Click the middle button to choose
session number 5 “WINDOWS XP”

2. Click the CHANGE SESSION button

3. Log-in with your CCID and password
(and click ACCEPT to the warning)

4. To access the internet: AUTHENTICATE Ef':-'f
using your CCID and password -

Authentication
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Practical Python Programming

Windows XP

1. Right-click the START button to choose EXPLORE

2. Navigate to the TEMP directory on the C drive

3. In a web browser, download the following to C:\TEMP:
http://tinyurl.com/ppp-zip

4. Extract all/lUnzip PPP.ZIP in to C:\Temp\ppp

5. Open pppl_tasks w2011.pdf, and then minimize for
future use

Outline

Who, when jwhat, where, why, how?
Easy environments

Programming primer

Beverage break ~ 10:30 a.m.
Coding conventions
Fussing with the flow
Excellent e-resources
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Who am 1?

Charlene Nielsen
ccn@ualberta.ca

GIS Analyst in Biological Sciences
http://www.biology.ualberta.ca/facilities/gis

E ] Department of ’
Biological Sciences \ {

Who is this workshop for?

e You, if you:
— Know how to use a computer and the web
— Have never programmed before but have a
strong desire to learn how

— Are willing to type a lot to make the
information stick (no copy paste allowed)

— Are an experienced programmer and want to
play with a new language

A
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Who uses it?
yazool (GO Ug[e"

Web Development

/OPE | Pinet
Corporation -
Graphics :
P A ®)blender’
Financial
=y BELLCO
. Bl B e e rehen arada

Science

& e, Fwy
&NOAA @esri

http://wiki.python.org/moin/OrganizationsUsingPython

Who uses it?

Electronic Design Automation CIRANQVA

alog layout automation

Software Development M redrat Sgi NOKIA

Connecting People

@ UNIVERSITY REGISTRAR

Education

UNIVERSITY of CALIFORNIA - [RVINE

Business Software

Government

http://wiki.python.org/moin/OrganizationsUsingPython
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Who is responsible for Python?

» Created by Guido van Rossum
— born 31 Jan 1956 (Netherlands)
— currently works at Google (since 2005)

P

DOCTOR FUN __ ]

i ACtlver malntalned by W0r|dWIde USGI’S (including van Rossum)

A

When?

» 1989 "hobby" programming project

— interpreter for a new scripting language descendant of
ABC that would appeal to Unix/C hackers

— needed a name that was short, unique, and slightly
mysterious — so was nhamed Python as a working title

* 1991 code first published (version 0.9.0)
» 2001 the Python Software Foundation was formed

More history:
http://docs.python.org/release/2.6.6/license.html
http://en.wikipedia.org/wiki/History of Python

Winter 2011



Practical Python Programming Winter 2011

When to (not) use it?

- PRO: Suitable for everyday tasks, therefore
minimizing the amount of time a
programmer spends on a project

- coN: Often less efficient than languages
such as Java, C, and C++, therefore, not
good when creating a new operating
system

What Is it?

* Aremarkably pOWfoUl, dynamic, object-oriented,

interpreted, high-level programming language
that is used in a wide variety of application domains

* Named after the comedy troupe: Monty Python

ccn@ualberta.ca 6
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What release: 2 or 3?

I'm the
tried
and true
blue #2!

“Python 2.x is the status quo, o
Python 3.x is the shiny new thing.”

2.7 is the last major release for 2.x,
with statement of extended support

3.1 is the intended future of the “cleaned up” language,
with less regard for backwards compatibility

A lot of third party software doesn't work on 3.x yet...

I'm the
clean
and
shiny #3!

“Well written 2.x code will actually be a lot like 3.x code”

Handy tools for compatibility:
— http://wiki.python.org/moin/2to3
— http://wiki.python.org/moin/3to2

http://wiki.python.org/moin/Python2orPython3

ccn@ualberta.ca

Build test suites for
C or Java code

Write GUI
interfaces

Process large
XML data sets

Control number-
crunching code on
supercomputers

Make a commercial
application scriptable
by embedding the
Python interpreter
inside it

Image from “Head First Python” book by Paul Berry

http://www.headfirstlabs.com/books/hfpython/
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Where can it be found?

* www.python.org Follow the
easy online

. installation
e WWW, aCtIVGStateCOm instructions!

» Automatically with certain operating systems
(e.g. Mac and Linux)

* Installed alongside software applications that

incorporate its scripting functionality
(e.g. ESRI ArcGIS)

Where can it be used?

» All major operating systems My
&

~ Windows Windows
— Linux/Unix A ubuntu®
L
- 0S/2 o2
— Mac
Mac
— Amiga AMIGA 08

And operating systems on mobile devices!

Winter 2011
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o Simplicity
and ease of

understanding

— Programs look neat
and clean

— Has few unnecessary
symbols

— Straightforward
English names instead
of the cryptic syntax
common in other
languages

T DUNNO..-
DYNAMIC TYPING? I JUST TYPED
MHITEGPACE? import ortigravity
/ coreTomsl | | THATS T2
T LEARNED ITLAST PROGRAMMING .. T ALSO SAMPLED
NIGHT! EVERYTHING IS FUN AGAIN! EVERYTHING IN THE
1S SO SIMPLE! ITS A WHOLE VEDICINE CABINET
/ NEL/ WORLD FOR COMPARISON
HELLO WORLD 15 JusT N UP HERE! |
print "Hello, world!” BUT O ARE BUT T THINK THIS
You FLYING? 16 THE PYTHOM.

Note: ‘import antigravity’ only works in version 3.x, print statement only in 2.x
http://xked.com/353/

Why use it?

* Programmability
— Wide range of readymade libraries that can be (freely!) used in
your own programs; i.e. “batteries included”

— Supports, but doesn't force, object-oriented programming (OOP)
— Integration with other languages (e.g. Java, C)

“Python Foot” graphic by David Day

A
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Why use it?

= SPECIAL SUPPLEMENY =~ —

| "“ﬂ- * Free

— Doesn't cost — freely usable and
distributable — even for commercial use

— Open source code

— Sizable community of developers with
online support groups

‘2 PyCon

Connecting The
Python Community

http://www.pycon.org

ccn@ualberta.ca

How can it be used?

» Scripting

— ‘gluing’ together commands for other software applications

* Programming

— text processing, web site development, email, scientific computing
http://www.devsource.com/c/a/Languages/More-Than-Five-Things-You-Didnt-Know-You-
Could-Do-With-Python/

* Python does COM

* Python does .NET

« Python does Java better than Java
« Python is high-performance

« Python talks to hardware

Education

— MIT and other institutions use Python as the programming
language in their introductory computer science courses

Winter 2011
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How can it be learned?

« Official Python tutorial
http://docs.python.org/release/2.6.6/tutorial/index.html

* Online resources, including “free” e-books
through UofA’s Libraries (listed at the end)

 Hands-on now!

 Command line
— The interpreter

» IDE (IDLE):
Integrated
Development
Environment
— Interactive window
— Script window

» Other software
(not used in this workshop)

Winter 2011
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The Python Interpreter

We're going to skip the command line, and go on to...

B Python (command line)

Python 2.6.5 (»265:790%76. Mar 19 2010. 21:48:26> [MSC v.1588 32 hit (Intel>] on n

win32
Type "help". “copyright", “credits" or "license" for more information. .

>>> print "And now for something completely different.
find now for something completely different...
>

~[g]

IDLE for Python in ETLC 5-013

Click START >>> PROGRAMS

A

>>> ACTIVESTATE ACTIVEPYTHON 2.6 (32-bit) >>> IDLE (PYTHON GUI)

) Accessaries
[ y [l 5 ActivePython Documentation
() Adaptive Technolagiss
{7 Adabe Web Premium C55
) Audacity

() DD CD Burming Software

» @ python Interactive Shel
» B Python Package Manager (PyPM)

() DD Flayer Software

(7 Google Earth (Authenticate first)
{7 HoTz000

() Microsoft Office 2003 (¥irtual)
() Microsoft Office 2007

[T) PDF Readers

[T SPSS Inc

lju =
FEE) Yo A Communications ¥ o)

) U of & Communications
) WinZip

Documents
-~ Settings

Search
) Help and Support

Run...

Shut Down...

id| Windows XP Professional

Winter 2011
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IDLE: Interactive window

7& Python Shell

M=%

Eile Edit Shel Debug Options Windows Help

{Intel}] on win32

IDLE 2.6.5

Python 2.6.5 (r265:79096, Mar 19 2010, 21:48:26) [MSC v.1500 32 bit _-|
Type "copyright", "credits™ or "license()" for more information.

B R L e s
Personal firewall software may warn about the connection IDLE
makes to its subprocess using this computer's internal loopkack
interface. This connection is not visible on any external

interface and no data is sent to or received from the Internet.
e sk koo ok ok ok ok ok ok ok ok ok sk ok ok ook ok ok ok ke ke ke sk sk ok ok ok ok ok ek ek ok ko ok

> print "And now for something completely different "
And now for something completely different...

Ln: 14 |Col: 4

http://docs.python.org/library/idle.html

http://hkn.eecs.berkeley.edu/~dyoo/python/idle intro/index.html

A

Interactive window menu: File

Create a new editing window | g Edic Shel

Open an existing file \\New Window

Open a list of recent files ~|_ > 2Pen...
\Eecent Files

Open Module. .
Save current window to the Class Browser
associated file (unsaved Pakh Browser
windows have a * before
and after the window title) gave
Save fs..,

Save current window to
different file without -] Print Window

changing the associated file
Close

. . Exit
Close all windows, quit _+<=

/ Save Copy As...

Debug  Cplions

Chrl+M
Chrl+O

A+
al4C

Chrl+5
Chrl+5hift+5
Ale+shift+3

Chrl+P

Alt+F4
Chr+Q

. Open an existing module
(searches sys.path)

Show classes and methods
in current file

Show sys.path directories,
modules, classes and
methods

Save current window to new
—— file, which becomes the
associated file

— Print the current window

~_ Close current window (asks

(asks to save if unsaved)

to save if unsaved)

Winter 2011
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A

Interactive window menu: Edit

Undo last change to current

window (A maximum of  Edit Shel Debug Options ‘Windows Help

1000 changes may be
undone)

Copy a selection into /CUE

system wide clipboard, then

delete the selection Paste
/Select All

Insert system wide
clipboard into window

Fird in Files. ..
. Replace. ..
Ask for a line number gnd o to Line
show that line )
Show call tip

Unda
Reda

LCopy

Eind...

Find Again

Find Selection

Show Completions
Show surrounding parens

Expand Word

Chrl+z | Redo Iast_ undone change to

Chri+shift+z  — | current window

Chrl+x _ Copy selection into system

Chrl+C wide clipboard

Crl+y

Chrl+a ~._Select the entire contents of
™~

Chrl+F the edit buffer

Chrl+i .

ChI4E3 \ O_pﬁn a searcl_1 dialog box

Alb4F3 with many options

Ctrl+H

o \\ gplen a;) search and replace

Ctrl+backslash 1alog box

Ctrispace

Chrl+0

alk+f

more...

A

Interactive window menu: Edit

continued

Edit

Shell Debug  Options

Undo

Redo

Cut

Lopy

Paste

Search for the string in the
selection

Select all

Find...

Open a search dialog box
for searching files

Open a small window with
function param hints \

Highlight the surrounding /

Find &gain
Find Selection
Find in Files. ..
Replace. ..

Go ko Line
Shiaw call tip

Shaow Completions
Show surrounding parens

Expand Word

Windows  Help

ChZ
CtrH-shift+2

Chrl
ChrH-C
Chrl+y
ChrHa

ChrHF
Chrs
CHHFS
Alk+F3
ChriHH

Ctrl+backslash

s Repeat last search

Open a scroll window
allowing selection keywords

A+ / and attributes

Ctrl+space
Chrl+0
alk+

\
X

Expand the word you have
typed to match another
word in the same buffer;

parenthesis

repeat to get a different
expansion

Winter 2011
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A

Interactive window menu: Other

Shell Debug ©Options  Windows

View Last Restart Fé j; Scroll the shell window to the last restart

Restart Shell Chrl+Fe Restart the interpreter with a fresh environment

Look around the insert point for a  DEBug. Options  Mindows  H
filename and linenumber, open
" Goto Filefline

! ) Run commands in the shell
the file, and show the line

under the debugger

Debugger
Show the stack traceback of Fhe L Stack Yiewer Open stack viewer on
last exception Auko-open Stack Viewer traceback

Toggles the window between configured size and ‘Windows Help
maximum height.

i ' Zoom Height  Alt+2
The rest of this menu lists the names of all open om hEg

windows; select one to bring it to the foreground —— *Fython Shel*
(deiconifying it if necessary).

Shell and Debug menus are not available in the script window

A

Interactive window menu: GTK*

Open a configuration dialog. Fonts, indentation,
keybindings, and color themes may be altered. Startup

. Preferences may be set, and Additional Help Sources
Lonfigure IDLE. . can be specified. On MacOS X this menu is not

present, use menu 'IDLE > Preferences...' instead.

Options  Windows Help

Help

Version, copyright, license, credits T about IDLE

Display summary file on

Access local Python documentation, if installed. IDLE Help all menu items

Otherwise, access www.python.org. T Python Docs Fi

(Additional Help
Sources may be added
here using Options >
Configure IDLE...)

*GTK = Good To Know!

Winter 2011
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Now try this...
. 7 idle
o CIICk Help > IDLE Help FontsﬂTabsl H\ghhghtingl Keysl Gener’all
— Close When flnlshed Base Editor Fant Indentation Width
I"ead | ng Ez::i:te 8 R Pytho: Standard: 4 Spaces!
Fo o o - -
» Click Options > Configure | =™ =
IDLE Size: 20 — Bold
— Examine each tab and
modify as needed AaBbCcDdEe
— E.g. change font FfGgHhIiJjK
(Fonts/Tabs tab) 1234567890
— E.g. add custom web/file :4=01{111
help link/path (General tab
and click Add button)
ﬂ M Cancel M

Programming primer

* Program

— A set of instructions or recipe that tells the
computer what you want it to do

Winter 2011
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Programming primer

« A Python program is divided into lines
— Each line physically ends before a newline

— Lines that are blank (contain only spaces, tabs, formfeeds and
possibly a comment) are ignored

— Breaking up statements on separate lines will break
your program!

thesunshines = True

Programming primer

 Indentation and whitespace required

— Leading whitespace (i.e. spaces) at the beginning of a
logical line is used to compute the indentation level of the line,
which in turn is used to determine the grouping of statements

— Trailing whitespace is ignored

— All lines you want grouped together must be indented
identically!

thesunshines = True

while thesunshines:

{(NO print “Skip work and go to the beach”

BEGIN/END thesunshines = False

or braces)}

Winter 2011
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Programming primer

« Comments
— Helps explain what the code is doing
— Ignored when executed
— Two ways to indicate comments:

# type comment here
““ type comment here

FERELE]

e Command Prompts (interactive mode only)
>>>

Now try this...

» Type the following in the interactive window:

>>> import this

>>> help()

>>> import Do NOT type the >>>

>>> topics
>>>NUMBERS

>>> strings # note the lower case

« Type quit or press Ctrl-C to exit the help system

Winter 2011
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Now try this...

» Type the following in the interactive window:

>>> help(keywords) # now retype with quotes around ‘keywords’
>>> help(‘print’)

>>> print ‘what is a blue moon?’

>>> abluemoon = ‘second to last full moon in a four-moon season’

>>> print abluemoon

>>> for once in abluemoon: o . .
print once # this is looping, we'll learn about ir later

* Type Alt-P a couple of times (and try Alt-N)

Do NOT type the >>>

A

Building blocks

computer

programs modules statements expressions

» Difference between a statement and an expression:
— Expression is something

— Statement does something
(or, rather, tells the computer to do something; e.g. print or assignment)

» Expressions consist of:
— Literal values

Variables

Operators

Parentheses (to override the built-in precedence system)
— And some other things...

http://docs.python.org/referencel/lexical _analysis.html

Winter 2011
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Literals

Notations for constant values of some
built-in types (i.e. the stuff you type directly)

—Numeric = plain integers, long integers,
floating point numbers, and imaginary numbers

— Strings = text
enclosed in ‘single quotes’ or “double quotes”

help(STRINGS')
help(NUMBERS))

ccn@ualberta.ca

Variables

* A name that represents or refers to a value
(i.e. the stuff you want stored for various uses)

— Dynamic — no need to define the type up front

— Created through an assignment statement that gives them
values using the ‘=" operator

— If you don’t have an assignment (i.e. a name to the left of the ‘=")
then Python stores it in the default result variable *_’
(note: type ‘" at the command prompt to view current value)

“Programmers use these variable names to make their code read more
like English, and because they have lousy memories. If they didn't use
good names for things in their software, they’'d get lost when they tried

to read their code again.”
(Learn Python the Hard Way)

Winter 2011
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3
Operators

» Tokens that work with or operate on values
* Includes:

— Arithmetic

— Assignment

— Comparison
Bitwise

Logical
Membership

— Identity

(Note: The smaller-font ones are not included in the next set of slides; look them up in the help!)

help(OPERATORS')
http://www.tutorialspoint.com/python/python basic operators.htm

Operators: Arithmetic

Add (Note: Concatenation when used with strings)
Subtract

Multiply  (Note: Repetition when used with strings)
Exponential (power) calculation

Divide

Modulus — return remainder from division

Floor Division — return quotient from division

Winter 2011
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Operators: Comparison

Equal to*

Not equal to (also <>)

Greater than
Less than
Greater than or equal to

Less than or equal to

*Remember that a single ‘="' sign is the assignment operator!

Operators: Assignment

Simple assignment operator*
(assigns values from right side operands to left side operand)

Add AND assignment operator
(add right operand to the left operand and assign the result to left operand)

Subtract AND assignment operator

(subtract right operand from the left operand and assign the result to left operand)

Multiply AND assignment operator
(multiply right operand with the left operand and assign the result to left operand)

Divide AND assignment operator
(divide left operand with the right operand and assign the result to left operand)

*Remember that a double ‘==" sign is the equality operator!

Winter 2011
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Keywords

- Areserved word or identifier that has a particular
meaning to the programming language

» They must be spelled exactly as typed here:

and elif if print
as else import raise
assert except in return
break exec is try
class finally lambda while
continue for not with
def from or yield
del global pass

help(‘keywords")

http://docs.python.org/reference/lexical analysis.html#keywords

Now try this...

» Type the following in the interactive window:

>>>1+2+3

>>>

>>> -4

Case is important!

>>>a= )
a=1 Ais NOT the same as a

>>>h,c=2,3
>>>A+b*c #thentypea+b*c
>>> ‘stuff’

>>>

Do NOT type the >>>

Winter 2011
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Now try this...

» Type the following in the interactive window:

>>> # calculator expressions

S T L EU R e el Samples demonstrated

and provided in
the PDF document

>>> # print statements

>>> # sequences

» IDLE is well-suited for testing out bits of code to
see how it works!

IDLE: Script window

* From the menu of the interactive (Python Shell) window,
click File >>> New Window

— Anew blank window (a.k.a. file editor) is used to type our

programs in
4 python_rules.py - C:\WorkSpace\python_rules. py
Fle Edit Format Run Options Windows Help
#! /usr/bin/env python =
# Bn excellent textbook is "Beginning Python" by Magnus Lie Hetland
ravens = "A C program is like a fast dance on a newly waxed floor by people carrying razors."
anonymous = "C++: Hard to learn and built to stay that way. "
feldman = "Java is, in many ways, C++-—."
flying circus = "And now for something completely different

print ravens

print anonymous
print feldman

print flying circus

| &
Ln: 13 Col: 0

Winter 2011
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Script window menu

Options | Windows  Help

Open a pane at the top of the edit window which shows
the block context of the section of code which is
scrolling off the top or the window

Configure IDLE. ..

Code Context

Run  Options  Windows H
Open or wake up the Python shell window
Python Shell

Run a syntax check on the module ~ check Module. Alttx
EC Ul +

Run Module  FS

Execute the current file in the __main__ namespace

Shell and Debug menus are not available in the script window
But, all the previously shown ones are: File, Edit, Windows, Help!
Run menu is not available in the interactive window

Script window menu: Format

Indent Region Chrl4]
Dedent Region Chrl
Comment Out Region Alt+3
Uncomment Region Alk+4

Shift selected lines right 4 spaces

Farmat  Run  Options  wWindows
Shift selected lines left 4 spaces \
Insert ## in front of selected lines

Remove leading # or ## from selected lines ——_

AUy FELITT [211% pi=]
Turn *all* tabs into the right number of spaces Unkabify Region Alt+8
—Fomgte-Fate——Ai+T-

Open dialog to change indent width ——— Mew Indent Width — Alt-+Ll

/ Format Paragraph Alb+3
Reformat the current blank-line-separated paragraph

Format menu is not available in the interactive window

Winter 2011
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A script

» Atext file containing the statements that
comprise a Python program

« Reusable, reusable, reusable — once created,
the script can be executed over and over without
having to retype it each time

» Any file editor (that saves as plain AScll) can be used,

but name the file with a .pYy extension

» But don’t forget about interactive mode completely, it
makes an excellent testing ground

Coding conventions

» Style Guide for Python Code
http://www.python.org/dev/peps/pep-0008/

— 4 spaces per indentation (no tabs ever)
— Maximum line length of 79 characters

— Always import modules after initial comments or docstrings and
import them separately (i.e. don’t scatter them throughout your code)
— Name:
* modules with lowercase
¢ classes with CapWords
« functions with lower_case_with_underscores
¢ constants with UPPERCASE (and possibly “_")

— Use blank lines to separate groups of related code
— Surround operators with single space on either side
— Avoid extraneous whitespace in other situations

— Consistency! You really should read through PEP 8

Winter 2011
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Now try this...

Type some of the previous statements you ve already
tried in to the SCript window

Samples demonstrated

and provided in
the PDF document

Save with a meaningful name and a .pPY extension to
your working directory
Optionally, click Run >>> Check Module

Click Run >>> Run Module (or the F5 key)

Fussing with the flow

Control the behaviour of a script by testing conditions
and looping through values

Flow control statements (similar to other programming languages)
specify how the program is executed

—if .
— while

— for

— Also try and With (but not covered in this workshop)
Keyword statement (typically) followed by a colon and
an iIndented block

http://docs.python.org/release/2.6.6/reference/compound stmts.html

ccn@ualberta.ca
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If

The if statement is used for conditional execution, a.k.a.
testing values and making decisions

Details: lets you perform an action (another statement or more) if
a given condition is true; if the condition is false, then the
block is not executed

Remember: when testing equality use == (and not =)

Extending the testing:

— elif allows you to check multiple expressions for truth value and
execute a block of code as soon as the first one of the conditions
evaluates to true (all following elif expressions are ignored)

— else is a catch-all in case previous condition(s) not met

http://docs.python.org/release/2.6.6/reference/compound _stmts.html

If

Generic syntax:

if expression: _Most basic
statement(s) minimum coding

elif expression:
statement(s)

else:
statement(s)

Can be abbreviated as a conditional statement:
x = true_value if condition else false_value

http://docs.python.org/release/2.6.6/reference/compound stmts.html

ccn@ualberta.ca
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while

The While statement is used for repeated execution as
long as an expression is true

Details: keeps executing (another statement or more) until the
condition becomes false

Remember: to code a finite loop; i.e. prevent the
possibility that this condition never resolves to a false
value (unless an infinite loop is actually desired)

Generic syntax:

while expression:
statement(s)

http://docs.python.org/release/2.6.6/reference/compound _stmts.html

for

The fOr statement is used to iterate over the elements

of a sequence (such as a string, tuple or list) or other iterable
object

Details: causes a section of a program to be repeated a
certain number of times by iterating (i.e. counting each)

Remember: this can loop through list-like objects and/or
numeric ranges

Generic syntax:

for iterating_var in sequence:
statements(s)

http://docs.python.org/release/2.6.6/reference/compound stmts.html

Winter 2011
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Now try this...

« Type the following in the SCript window:

>>> #if

>>># XifCelseY Samples demonstrated
| and provided in

>>> # while the PDF document

>>> # for

Built-in functions

* A series of statements
which returns some value

to a caller

(it can also be passed zero or more
arguments for its use/execution)

Objects that can be used
by all Python code without
the need of an import
statement

dir(__builtins_)
http://docs.python.org/release/2.6.6/library/functions.html
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Built-in functions

Some of the tools that are always available to use:

abs(x)

bin(x)

cmp(x, y)

complex([reall, imag]])
dict([arg])

dir([object])

divmod(a, b)
enumerate(sequence], start=0])
eval(expression[, globals|, locals]])
file(filename[, model[, bufsize]])
float([x])

format(valuel, format_spec])

See http://docs.python.org/release/2.6.6/library/functions.html for complete listing

globals()
help([object])
hex(x)
id(object)
input([prompt])
int([x[, base]])
isinstance(object, classinfo)
iter(o[, sentinel])
len(s)
list([iterable])
locals()
long([x[, base]])

Built-in functions

More selected tools:

map(function, iterable, ...)
max(iterable[, args...][, key])
min(iterable[, args...][, key])
oct(x)

open(filename[, mode[, bufsize]])
pow(x, y[, z])

range([start], stop[, step])
raw_input([prompt])
reversed(seq)

round(x[, n])

See http://docs.python.org/release/2.6.6/library/functions.html for complete listing

set([iterable])

sorted(iterable[, cmp], key], reverse]])
str([object])

sum(iterablel, start])

tuple([iterable])

type(object)

type(name, bases, dict)

vars([object])

xrange([start], stop[, step])
zip([iterable, ...])
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Required keyword: d ef

User-defined functions

» Ablock of organized, reusable code that is used
to perform a single related action, that yOuU create

« Similar to procedures, subroutines, and functions
in other programming languages, but may or may
not return a value

» Generic syntax:

def functionname( parameters ):
"""function_docstring""
function_suite

defines the function return [e_xpression]

Modules

» Basically, subprograms that define things,
e.g. functions, classes, variables

e Built-in (as opposed to user-defined) modules
are also called standard libraries

http://docs.python.org/release/2.6.6/library
http://www.doughellmann.com/PyMOTW/
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Modules

 Different ways to grab these extra tools:
1. import <module name>

* Requires module name as prefix to tools
e.g. import random
randvalue = random.random() * 100

2. from <module name>import <function>

* Reduces typing for commonly used tools
e.g. from random import random
randvalue = random() * 100

3. from <module name> import *
(this way is not advised because it causes clutter)

The Cheese Shop

- The Python Package Index is
one-stop ‘shopping’ for all registered
module packages:

http://pypi.python.org/pypi
» Searchable!

Now then,

please, my
good man.

Certainly, sir.
What would
you like?

some cheese
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Some final notes

» As with all things and in Python, it's

Easier to Ask Forgiveness
than Permission

 l.e. try and perform an operation; if all goes well,

great; if not, ask for forgiveness

» Although, not demonstrated in this workshop, this is

error handling and is done with try/except

 The FAQ is a worthwhile read:

http://docs.python.org/faqg/index.html

Five tips for Python

Don't work too hard — let Python do the work for you by
using the stuff built in to its standard library

Don't write a loop when a comprehension will do —
built-in syntax for transforming one data structure (lists,
dictionaries) into another version of itself without resorting to
iteration

Learn as you go, not all at once, and learn constantly
(remember, concepts are the important things)

IDIl_I)E is often good for quick jobs (and has some useful
tools

Don't reinvent the wheel — check the Python Package Index
(PyPI) first

http://answers.oreilly.com/topic/2227-how-to-tackle-python-head-first/
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Skeleton script suggestion

Set up a generic_code.py (name it what you want)

Use comments/docstring at the top to indicate the
filename, date(s), your name, optional contact info, and
details about what the script requires and does

Type out the basic structure of your common coding
needs; including import <commonly used module(s)>

Open the file when you're ready to start a new program,
simply saving as a new appropriate hame before
modifying

A

So, are you now a fledgling pythoneer?
OR
Do you feel like you've found the ‘holy grail’
of programming languages?

A
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PyEd, anyone?

f,‘ LocalUserGroups - PythonInfo Wiki - Windows Internet Explorer =3}

@‘\ - Ia http: //wiki.python.org/moin/LocalUserGroups #Canada j @ 1% Ibi ng P

Fle Edit W¥ew Favorites Tools Help

¢ Favorites @ | ocalUserGroups - PythonInfo Wiki | | il - ] g v Page~ Safety~ Tooks- @+ 7
Canada

+ TorontoDjangoPython - Toronto Python/Django User group.
« MontrealPython - Montreal's Python community.

+ OPAG - Ottawa Python Authors Group. A group devoted to
learning, using and providing resources for Python. OPAG also _
serves as a general gathering place for Python programmers
from the Ottawa region and beyond.

+ PyGTA - the Toronto Python/Zope User Group meets regularly to
explore the expanding world of Python and Zope.

+ KWPUG - the Kitchener/Waterloo Python User Group - just
starting July 17, 2006.

+ WinniPUG - Winnipeg Python Users Group - active since
December 2005.

+ VanPyZ - The Vancouver Python and Zope User Group discusses
Python and various uses of the language.

=
[T [ || | @ mtemet | Protected Mode: On v |®mwen -

2
Future Python group activities

More AICT Workshops with Python

Software Carpentry:
http://software-carpentry.org

MIT Intro to Computer Science Programming:
http://academicearth.org/courses/introduction-to-
computer-science-and-programming

Read the related article on the importance of programming skills:
http://www.python.org/doc/essays/cp4e.html

http://www.python.org/community/sigs/current/edu-sig/
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E-resources

(online links to software, documentation, free books, tutorials, sample code, and articles)

e http://www.python.org/

¢ http://hetland.org/writing/instant-python.html

¢ http:/rgruet.free.fr/PQR26/PQR2.6.html

¢ http://diveintopython.org/

¢ http://www.headfirstlabs.com/books/hfpython/

¢ http://learnpythonthehardway.org/

¢ http://greenteapress.com/thinkpython/

¢ http://homepage.mac.com/s_lott/books/python.html
¢ http://www.tutorialspoint.com/python/

«  http://www.developer.com/lang/other/article.php/3624681/Python-Tutorial-Index-Page.htm
¢ http://www.swaroopch.com/notes/Python

¢ http://www.korokithakis.net/tutorials/python

«  http:/oreilly.com/python/

«  http://en.wikipedia.org/wiki/Comparison_of programming_languages
¢ http://code.activestate.com/recipes/langs/python/

*  http://pypi.python.org/pypi

e http://www.python.org/doc/humor/

UofA e-books

(subscription is accessible through an on-campus computer with a UofA IP address)

http://www.springerlink.com/

e Pro Python, Marty Alchin

¢ Python Programming Fundamentals, Kent D. Lee

e APrimer on Scientific Programming with Python, Hans Petter Langtangen

«  Python Scripting for Computational Science, Hans Petter Langtangen

«  Beginning Python Visualization: Crafting Visual Transformation Scripts, Shai Vaingast
« Dive Into Python, Mark Pilgrim

«  Foundations of Agile Python Development, Jeff Younker

«  Beginning Python: From Novice to Professional, Magnus Lie Hetland

http://site.ebrary.com/lib/ualberta/home.action

«  Python Programming for the Absolute Beginner, Michael Dawson

«  Gray Hat Python: Python Programming for Hackers and Reverse Engineers, Justin Seitz
«  Python: Create - Modify — Reuse, James O. Knowlton

«  Python Power!: The Comprehensive Guide, Matt Telles

Most recently published (and latest editions) listed from top to bottom
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UofA e-books

(subscription is accessible through an on-campus computer with a UofA IP address)

http://proguest.safaribooksonline.com/

¢ Programming Python, Mark Lutz

«  Python Algorithms: Mastering Basic Algorithms in the Python Language, Magnus Lie Hetland
¢ Head First Python, Paul Barry

*  Python Testing, Daniel Arbuckle

¢ The Quick Python Book, Vern Ceder

«  Python Programming for the Absolute Beginner, Michael Dawson
«  Python Pocket Reference, Mark Lutz

«  Learning Python, Mark Lutz

«  Python Essential Reference, David M. Beazley

«  Python: Visual QuickStart Guide, Toby Donaldson

«  Expert Python Programming: Learn best practices to designing, coding, and distributing your
Python software, Tarek Ziadé

«  Python Programming in Context, Bradley Miller and David Ranum

«  Python Power!l: The Comprehensive Guide, Matt Telles

«  Python Phrasebook: Essential Code and Commands, Brad Dayley
*  Core Python Programming, Wesley J. Chun

¢ Python in a Nutshell, Alex Martelli

«  Python Cookbook, Alex Martelli, Anna Ravenscroft, and David Ascher
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